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Steady State Process Simulation Using ASPEN Plus

It is based on steady state governing equations like conservationof mass,
momentumand energyof variousunit operationsand unit processes

* The governingequationsresults operating conditions of the processplant like,
flowrate, enthalpy (temperature), pressure, compositions of each streams,
amountof energyneeded,overallyield, conversionstc.

 The steady state process simulation utilizes thermodynamic and transport
propertiesof variousspeciesequilibrium data of vaporliquid, gasliquid, liquid-
liquid, solidtliquid, and chemicalequilibriumdata.

* |t determinesthe sizeof equipmentin a chemicalbplant.



Start

» Beginby openingAspenPlus Aregistrationscreen(connectto engine)comesup;
click OK Click‘maximize’to fill the screen Thisstep may differ dependingupon
installation

e Foranew problem,it isusefulto choosea templatethat is similarto a problen
Model Library

« Model library consistsmoduleswhich are the replicaof variousunits usedin the
flow sheetingof a chemicalprocesslant.

* |t canbe viewedclickingon the iconsat the bottom of the AspenPlusscreen If
the iconsare not displayed,choosethe View/Model Libraryfrom menu option.
Whenthe unit is clickedthe wordsshownat the bottom of the screengivea brief
descriptionof the module
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Selected Major Blocks Available in Aspen Plus

* Mixers/splitters
a. Mixer—combine material
b. Fsplit— split specifications for output
c. Ssplit—splits usingsubstreams

e Separators
a. Flash2-rigorous vapoHiquid split or vapoHiquid-iquid split
b. Flash3-rigorous vapoHiquid-iquid split
c. Decanter separate two liquid phases
d. Sep-use split fractions
e. Sep2-separation based on flows and purities

* Heat exchangers
a. Heater heaters, coolers, condensers
b. HeatX— co- and countercurrent heat exchangers
c. Hetran—shell and tube heat exchangers
d. Aerotran—air-cooled heat exchangers



e Columns

a. DSTWU shortcut distillation using WindUnderwood-Gilliland equations and
correlations

b. Distl—- Edmistershortcut distillation

c. RadFrae-rigorous two phase and three phase, absorber, stripper, distillation
columns using stages

d. Extract- liquidHiquid extraction

* Reactors
a. RStoic- stoichiometricfractionalconversionor extent of reaction
b. RYield- nonstoichiometric- basedon yield distribution
c. REquit-rigorousequilibrium
d. RGibbs-rigorousequilibriumand/or multiphaseGibbsfree energyminimization
e. RCSTRcontinuousstirred-tank reactor, specifyvolume
f. RPlug- plugflow reactor,specifylengthand diameterof tube
0. RBatch- batchreactor,specifycycletimes

The RCSTRRplug and RBatchreactorsrequire the choiceof a reactionset and the
buildingup of areactionrate expression



* Pressure changes
a. Pump
b. Compr—compressor

» User model



Aspen Plus Simulation
Vaporliquid equilibriain a flashchamber

Problem Fora mixture (100 mol) of propane,n-butane,n-pentene,andn-octane,phase
equilibrium K-valuesand inlet compositions{z} are givenin the table below at 180 °F
and 70 psi. Estimatevapor{y;} and liquid {x;} phasecompositionsyapor productV and
liquid productLin aflashchamberusingAspenPlussimulator.

Componentsi : Phase

Equilibrium K
value
propane 0.1 6.8
n-butane 0.3 2.2
n-pentene 0.4 0.8

n-octane 0.2 0.052




« Start Aspenand chooseTemplate OK Whenthe window appears,chooseGeneralwith
EnglishUnits. In the Run Type (lower right-hand corner), choose Flowsheet Click OK
whenthe Aspenenginewindow appears (Thislaststepis specificto your installation)

e Or

» ClickAspenTech selectAspenPlus10.1-0, and clickAspenPlusUserInterface TheAspen
Plus Startup dialog box appears You can use this dialog box to open an existing
simulationor to create a new simulationusinga template or a blank simulation. Select
the BlankSimulationoption and clickOKto start the new AspenPlussimulation



Aspen Plus Main Window
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e From the File menu select
Open

 The Open dialog box appears
Your default working directory
IS displayedin the LookIn box
You can navigateto the folder
containing a file by using the
Look In box or the Look In
Favoritesbutton

e Click the Look in Favorites
button.



A list of folders is displayed in the Open dialog box:

e

Look in: | 3y Favorites

2. Assay Libranes

] Data Package
o Electrolyte Inserts
Examples

_ I Applications: [No preview available.

File name:

Files of type:  |Aspen Plus Files [*.bkp, *.apw, *.ap!, *.inp) LI

Open |

Cancel |

Doubleclick  the
Exampledolder.
From the files list,
selectflash.bkp and
clickOpen

Click Yes when
AspenPlusprompts
"Do you want to
close current run
before openingnew
run?"

Click No when
AspenPlusprompts
"Save changes to
Simulation1?"



o If the bottom of the screendoes not show the units, use the View/Model Library pull-
downmenuor pressthe FLOkey. In the unitsat the bottom, chooseSeparationsthen click
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Flowsheet for Flash2 unit

on Flast?. Clickon the flow sheet,andthe flash (phaseseparation)unit appears

|- Azpen Plus - flagh. bkp A= E

To add the input and output
streams, click on Material
Streams (lower left-hand
corner), click on the flowsheet
and drag a streamto the red
arrow that is input to the flash
unit. Clickon the red arrows
coming out and drag the
streamaway

If any red arrows show in the
flowsheet, it means that the
unit is not properly connected
it will message(Bottom right
corner) in the status indicator
‘Flowsheetnot Completé
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If the flowsheet is
complete, the status

indicator message
‘Required Input
incompletée.

Clickon Next button or
Data browser button
In the in the toolbar.

The data browser
dialogue box  will
appear Thiswill bringa
menuto the left of the
screen

The boxesthat are red
indicate that you still
need to supply
information. Start at
the top and work
down, turning the red
boxes into blue boxes
by filling in the forms.



 FillingComponent/Specifications the data browser
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. T%/pe the name or formula of the chemicals If Aspen Plus does not recognizeyour
chemical,a window appearsthat allowsyou to searchagain,and it will suggesta number
of possibilities Whenthe componentsare completelyspecified,you shouldhavean entry
for everychemicalin the columnlabeled Componenthame Thefirst columnis what you
are namingthe chemicals put the third columnis what AspenPlususeswhen it obtains
physicabroperties If that columnis blank,the programwill not work.

Comporentname | Fomula
N-EUTANE (C4H10-1




 FillingProperty/Specifications
e Choose the thermodynamic model
» UsingRedlickKwongequation of state option in Aspen Plus



 FillingProperty/Specifications
» Choose the thermodynamic model



 FillingStreams

e Choose the input stream, click on it, and insert the temperature, pressure, and flow rat
every chemical.



* FillingBlock

* In the list at the left, chooseBlocks,then Bl (or whateveryou have namedyour Flasl2
unit), then Input. ChooseSpecificationsand insert the temperature and pressureof the
unit.



Flash2 Results

» Chooséhe nextbutton at the top. If

the input is incomplete, a window
will appearto notify you and direct
you to the missingdata. If the input
IS complete, a window will appear
to notify you of that, too. Clickon
the button to make it perform the
calculation This will cause the
calculationof the process(here one
unit) to proceed Once the
calculationsfinish (read the error
messagesif any), click the Results
box (lower one) to return to the
regular menu Then look at
Results/Streams The stream data
will appear in tabular form, as
shown in Table 3.3. If you click
Stream Table, it will also be
reproducedon your flowsheet



Model the T—xy or p—xy diagramfor the vapor-iquid of binary pairsusingProperty Analysis

« Stepl: Start Aspenand chooseTemplate Awindow appears chooseGeneralwith Metric
Units. From the Tools menu, select Analysis then Property, then Binary. The Binary
Analysiglialogboxappears






The options for the fugacity coefficient of tigaseous phasare:ideal gas Redlichk-
Kwongor Redlich-KwongSoave Peng-Robinson plus a few specialized ones.

In the liquid phase, the simplest option isideal liquid, That choice leads t&aoult’s
law. Other models includé\RTL.Electrolyte NRTIUNIFACUNIQUACVanLaar, and
Wilson.

Oil and GasProduction (OILGAS)- Peng-Robinsonwith Bostor-Mathias a function
(PRBM) or Redlichk-Kwong-Soavewith Bostonr-Mathiasa function (RKSBM).

Refinery, medium pressure (Refinery) — Chae-Seader Grayson, Peng-Robinson,
RedlichkKwong-Soave

Refinery, hydrogenrich applications (Refinery)— Grayson,Peng-Robinson,Redlick
Kwong-Soave

Gasprocessing hydrocarbonseparations(GASPROG) Peng-Robinsonwith Boston-
Mathias a function (PRBM), RedlichkKwong-Soavewith Bostorn- Mathias a function
(RKEBM), Peng-RobinsonRedlichk-Kwong-Soave
GasProcessingacidgasabsorption(Chemicabnd Electro) —electrolyteNRTL
Petrochemicalsaromaticsand ether production (Petchen) —Wilson,NRTLUNIQUAC



» Chemicals, phenol plants (ChemicalWilson, NRTL, UNIQUAC.

* Chemicals, ammonia plant (ChemicallPeng-Robinson, Redlieclkkwong-Soave, SRolar
(SchwartzentruberRenor).

* Chemicals, inorganic chemicals (Chemical &heictro) —electrolyte NRTL.

» Coal processing, combustion (Coalpro¢ — PengRobinson with Boston-Mathias a
function (PRBM), RedlichkKwong-Soavewith Bostor-Mathias a function (RKSBM), or
the combustiondatabank



MULTICOMPONENDISTILLATIOWITHRadFrac

* Problem The feed is 100 Ib mol/n propane 300 Ib mol/h i-butane, and the other
chemicalsaslistedin Table,at 138 psiaand 75°F. Thecolumnoperatesat 138 psiawith 26

stages,reflux ratio 3.44 and feed entranceon the 19 stage The Refinery/ChaeSeader
property methodisused

* Onthe AspenPlusStartupdialog box, selectthe Templateoption. ClickOKto continue
TheNewdialog box appears

» Selectthe Generalwith EnglishUnits template for this session The default Run Type,
Flowsheet is appropriatefor this session

 ClickOKto startthe new AspenPlussimulation






* Fromthe AspenPlusmainwindow, clickthe Columngab onthe Model Library.

 Move the mouseover the RadFracblock and read the prompt. The prompt for RadFrac
suggestghisisthe right modelfor this problem

 ClickRadFracthen pressthe Helpkey (FL).

» Tochoosea different iconfor RadFracclickthe down arrow to the right of RadFraadn the
Model Library
« Selectthe iconlabeledFRACT underthe RadFradlock
 Clickthe iconanddragit to the Procesd$-lowsheetwindow.
 Clickthe Material Streamicononthe left sideof the Model Library.



The insertedRadFradlock Ports that must have at least one stream connected are
shown in red. Optional ports are shown in blue. If you
positionthe mousepointer overa port for a few secondsthe
arrow is highlightedand a descriptionof the port appears



Toconnectthe feed streams

Graphicalsimulation flowsheet is now
complete The status indicator in the
bottom right of the main window says
"Requiredinput Incomplete' indicating
that further input specificationsare
requiredfor the simulation



Entering Components

e Clickthe Next button on the Data Browser window toolbar. Data browser window
appears

* In the first Component ID box, type PROPANE and press Enter.
 Click the next blank Component ID box, Type BUTANE and press Enter.

Selecting Thermodynamic Methods

» Usethe Properties SpecificationsGlobalsheetto selectthe thermodynamicmethods
usedto calculatepropertiessuchasK-values enthalpy,anddensity

 In generalthe UNIFA(roperty methodfor liquid phasenonideality ischosen
 But for refinery productRefinery/ChaeSeademproperty method is used.

EnteringStreamData

» Enterthe followingstate variableand componentflow specificationgor the feed stream

» feed is 100 Ib mol/h propane 300 Ib mol/h i-butane, 500 Ib mol/h n-butane, 400 Ib
mol/h i-pentane,5001b mol/h n-pentane

e P=138psiaand T=75F



Entering Unit Operation Block Data
» Clickthe Next buttonon the Data Browser window title bar.

* The AspenPlusexpert systemdisplaysa CompletionStatuswindow, stating that you
needto enter Number of stages Condenseltype, specificationsjn order to complete
this sheet

« Now enter the operating
specifications  for the
column

o« 26 stages Set the reflux
ratio to 3.44 and enter the
feed on the thirteenth
stage.



Running the Simulation
 Clickthe Next buttonon the Data Browser window toolbar.
» ClickOKon the Required Input Complete dialog box.

 The Control Panel allows you to
monitor and interact with the
AspenPlussimulation calculations
» Thesimulationcalculationsoccurin
three sequentialsteps
1) Processingnput specifications
2) Calculationdegin
3) Generatingesults



Examining Block Results
e ClickThe individualockn the simulation flowsheet.
e SelectResultdrom the menu

» Clickthe Profilesform in themenu treeon the left side of the Data Browser window.

TABLE Stream data for
Multicomponent Distillation with
RadFracRefluxRatio=3.44

86% of the propane goesout
in the top streanm along with
4% of the i-butane. The
condenseis at 80°F and hasa
heat duty of —2.94 x10° Btu/h,
and the reboiler is at 199.5°F
and has a heat duty of 115
x10° Btu/h. Above the feed,
the flow rate varies between
283 and 344 |Ib mol/h, and
below it, the flow rate varies
between 2998 and 3097 Ib
mol/h.



Calculation with higher reflux ratio

» Forreflux ratio 5, 94.2lb mol/h of propanegoes out in thdop stream Increasing the
reflux ratio to7.5gives98.21b mol/h of propane and a reflux ratio of0 gives99.21b
mol/h of propane

Fig.Condenseandreboiler calculations for Multicomponent distillation witRadFracgreflux ratio = 3.44.



Reactors
« Chemicateactionsoccurunderdiverseconditionsin manydifferent typesof equipment

* RStoi¢RYield RGibbsand RCSTRanhaveany numberof material feed streams which
are mixed internally. Heats of reaction are not required for any reactor model. Aspen
Pluscalculatesheatsof reactionusingheatsof formation.

 ForRCSTHRPIlug andRbatchutilize reactionkineticsinformationusing

1. Thebuilt-in powerlaw model
2. Thebuilt-in generalized_angmuirHinschelwoodHougenWatson (LHHWModel
3. Auserwritten Fortransubroutine

* Rstoic
1. Reactionkineticsare unknownor unimportant.
2. Extentof reactionor conversioncanbe specified
3. Rstoiccanhandlereactionsthat occurindependentlyin a seriesof reactors
4. It canalsoperform productselectivityandheat of reaction calculations



* RYield

RYieldmodelsa reactor by specifyingreactionyieldsof eachcomponent Thismodelis
usefulwhen:

1. Reactionstoichiometryandkineticsare unknown
2. Yielddistributiondataor correlationsare available
* REquil

REquil models reactors when some or all reactions reach equilibrium. REquilcan
calculate singlephase chemical equilibrium, or simultaneous phase and chemical

equilibria REquilcalculatesequilibrium by solvingstoichiometricchemicaland phase
equilibrium equations

* Rgibbs

1.

2.
3.

RGibbsmodels singlephase chemical equilibrium, or simultaneous phase and
chemicalequilibria

reactortemperature and pressure or pressureand enthalpy are specified

RGibbsminimizes Gibbs free energy, subjectto atom balance constraints This
modeldoesnot requirereactionstoichiometry.



o

Rgibbscandetermine phaseequilibrium without chemicalreaction, particularly for
multiple liquid phases

Assigrcomponentso bein particularphasesan equilibrium
Usedifferent property modelsfor eachliquid or solidsolutionphase
Chemicakquilibriacanbe restrictedby specifying

|. Fixedmolesof anyproduct

Il. Percentagef afeed componentthat doesnot react

lll. Fixedextentsof reaction

V. Temperatureapproachto equilibriumfor the entire system

V. Temperatureapproachedor individualreactions

RCSTR

1.
2. Thecontentsof the reactorhavethe samepropertiesasthe outlet stream

3.

4. RCSTRomputesheat duty giventhe temperature or temperature giventhe heat

Reactionkineticsare known.

RCSTBanmodelequilibrium reactionssimultaneouslywith rate-basedreactions

duty.



* RPlug
1. RPlugigorouslymodelsplugflow reactors
2. Acoolingstreamaroundthe reactoris optional.
3. RPlugnmodelreactorswith cocurrentand countercurrentcoolantstreams
4. RPlughandlesrate-basedkinetic reactionsonly.

* Rbatch
1. RBatchrigorouslymodelsbatch or semtbatchreactors

2. For semtbatch reactors, a continuous vent and any number of continuous or
delayedfeedscanbe specified

3. RBatchhandlesrate-basedkinetic reactionsonly.






Ammonia Process

* Thefeed to the processis nitrogen, hydrogen,and a smallamount of carbondioxide
(left overfrom the processo makethe hydrogen)

 Input streamto the processat 80°Fand 300 psia): nitrogen,100Ib mol/h; hydrogen,
300 Ib mol/h; ammonia, O; and carbon dioxide 1 lIbmol/h. The inlet stream is
compressedo 4000psiwith anisentropiccompressor

* The processfeed is mixed with a recyclestream and heated to 900°F, the reactor
temperature,and sentto the reactor. Thefeedto the reactoris roughly a 3:1 mixture
of hydrogenand nitrogen,with someammonia,too.

* Inthe reactor,thereisapressuredrop of 30 ps..

» Theoutlet iscooledto 80°Fandthe liquid andvaporphasesare separated
* The vapor phase goes tecycle and0.01 percenbf it is used apurge.

« Arecycle compressdhen compresses the rest froB8970 to 4000 psia

« A small part of the recycle streamblked off as a purgetream to prevent théuildup
of impurities.



ASPEN Flow Sheet of Ammonia Process



The identification of components

* It is useful to check the connections between the units using the Flowsheet
option/Section//GLOBAL

Components of the process



» After selecting Flowsheetoption/Section//GLOBAL the data browser screenis

shownin the followingfigure:

Flowsheet in brief

Any disconnected stream
will not show its numbers
that is shown by input
streamID and Port.



The operating parameters for the compressors
* Anisentropic compressor (Bl the feedstream tocompress feed gases
» Discharge pressu000psi..



* Anisentropic compressor (B9 therecyclestream tocompress recycle gases
« Discharge pressu000 psi



The operating parameters for the heaters

« Aheater (B3)in thereactor inletto heat the reactor feed t®®00°F, and at a pressure of
4000 psi



« Acooler (B5)n thereactor outletto coolthe reactor product td80°F, and at a pressure
of 3970 psi



The operating parameters for the reactor

* AGibbs reactor (B4ARGibb3$operated at a pressure @970 psiand at a temperature of
900°F.






The specifications for the mixer (B2)



» The specifications for the separator/flash chamber (B6, flash2)



Specifications for the simple splitter (B&Spli)



 In Aspen Plus streams and units different operating conditions likeet¢.cBn be
specified.

Aspen Plus convergence



Seqguential module for iteration
« Unit B1 is calculated only once, since the exact input to that unit is known.
* Then units B2B9 are calculated.

» Since B9 is the last unit, Aspen Plus compares the output from unit B9 on this iteration
the output from unit B9 one iteration before. If they are the same, convergence has bee
achieved.

e |f not, it iterates more.



This simulation used the
Wegstein method  of
acceleratingconvergence

Thesolutionshavenot full
converged  after 3
iterations; the  mass
balanceerror isin block B9
(the recycle com ressor)
discrepancyas 0.5805 vs
0.5801, for a relative
differenceof 0.07 percent

The small difference is
acceptable

The Broyden method does
not convergemuchbetter.

Direct method of iteration
did converge

It calculates all the
equations simultaneousl
around the loop over an
overagain



Mass balance for ammonia process

» Discrepancybetween streams9 and 10; hydrogenflow rate is off by 0.05 Ib mol/h,

comparedwith atotal flow of 14901b mol/h.

« Conversions (135'253}’533\;‘,{9)1002 73%0f N, whichis a limiting reactant.

* Most of the carbondioxide 1 Ib mol/h goesout in the product ammoniastream and
remainingl.91 Ib mol/h in the recyclestreant the purgestreamwasno carbondioxide
Soit Isnot necessary




Energy balance for ammonia process



Feed compressor variables, unit B1.

The compressor is
very large ~ 900 HP
with compression
ratio 4000'300=13.3.
Instead, two stage
compressorseach of
compression  ratio
v13.3 = 3.65 can be
used to maximize
work efficiency

From the
thermodynamics
point of view, optimal
configuration has
equal compression
ratios with inter-stage
cooling back to the
inlet temperature



Recycle compressor variables, unit BO.



Heat exchanger (upstream to the reactor) variables, unit B3.



Heat exchanger (downstream to the reactor)variables, unit B5.

From given heat duty
capital cost can be
estimated

Enthalpies of the
process streams from
energy balance table
can be integrated over
the process combined
with the heat duty that
verifies the overall
energybalance



Mass balance for ammonia process (repeated figure)

Equilibriumpersistsin the reactor effluent.

Fromthe thermodynamicof chemicalequilibria, K-values can be calculatedfrom the
mole fraction of the screams.

W = 0.0204; U = 0.8346; W4, = 0.1434; w= uuuyYaa

It is closeto the valueof 0.00473measuredby Stephensor{1966).
Thereactorutilizesthe NRTLthermodynamicmodelfor chemicalreaction equilibrium.



Testing vapoiliquid equilibria in streams 6 and 7

e Solubility of nitrogen is 27.6 cm3g ammonia when the pressureis 270
atm(~4000psia)andat 25°C(~80°F). It correspond.021 mole fraction of

nitrogen in the liquid phasethat is interpolated from valuesmeasuredby
Stephenand Stephen

e Usingthe valuesfor stream 6 from the massbalancetable givesa mole
fraction of 0.0061that is smallerthan literature but there is carbondioxide
(ternaryequilibrium)in the streameé.



